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IMPORTANT SAFETY MARKINGS

The following symbols are used throughout this User Guide to advise you of important instructions:

This symbol warns the presence of a voltage of sufficient magnitude to cause a
severe or fatal electric shock. Follow the appropriate instructions carefully to
avoid the risk of injury.

This symbol indicates an important instruction for the correct and safe installation,
operation or maintenance of your ImageStar HD system. Failure to comply with such

instructions may result in injury to personnel or damage to the ImageStar HD
hardware.

C€

This product conforms with the protection requirements of the EC Directive
89/336/EEC (relating to Electromagnetic Compatibility) and EC Directive 73/23/EEC
(relating to Low Voltage) by application of the following standards:

EN 55103-1:1996; EN 55103-2:1996; EN 60950:2000
Provided that:

¢ The product is used in accordance with the manufacturer’s instructions.
e The product is not connected to any peripheral equipment that is not CE marked.

This device complies with part 15B of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received, including interference that
may cause undesired operation.
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What is ImageStar HD?

ImageStar HD is a compact, high performance image processor for scaling a variety of input source
types, including high definition video or graphics, across up to four displays. Using additional units it is
possible to create larger target displays.

Up to four inputs may be simultaneously connected to the unit. A built-in switcher allows the displayed
source to be selected. Each output can display a magnified component of the selected source.

Firmware & Software Versions

This User Guide is based on the following ImageStar HD firmware and software versions:

e ImageStar HD firmware v1.0.0.23
e ImageStar Configuration software v1.2.3

Electrosonic may periodically release updates to the firmware or configuration software in order to
provide new or enhanced functionality. Details of any updates can be obtained by:

e (Clicking the Product Support link on the System Disc browser, or

e Selecting the Check for Updates option in the Help menu of ImageStar HD Configuration, or
e Visiting the Electrosonic web site www.electrosonic.com/support

Page 10 1460GB issue 4
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Typical System Application

Single Unit Example

Using a single ImageStar HD to show a source on a 2x2 target display:

Source

Multiple Unit Example

Using four ImageStar HD units to show a source on a 4x4 target display. Each ImageStar HD drives
four screens in the display:

Source

Distribution Amplifier

ImageStar HD

ImageStar HD

ImageStar HD

ImageStar HD

1460GB issue 4 Page 11
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Front Panel Features

CONTROL PANEL
SELECT Infra Red
button Sensor
Active Input
Indicators
® ® @
. TREY ImageStar HD
o st weur ELECGROSONIC
v \mw

POWER NETWORK
INDICATORS

Indicators

G The green power indicator is lit continuously when the unit is receiving power from the
external PSU.

=== The amber network indicator flashes when network data is being received or transmitted.

SELECT Button

A push-button used to switch between connected source inputs.

INPUT (1-4) Indicators

During normal operation the lit indicator shows which input is currently selected for display.
During the boot-up period (around 30 seconds after power is applied or following a reset) these
indicators will cycle through various diagnostic patterns.

Infra Red Sensor

Reserved for future use.
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Rear Panel Features

USB SOURCE INPUT CONNECTORS
CONNECTOR RGB Composite / S-Video

e R O
= 1= J
@ Q “ oW Ve mmn @ @ HHE: e e HEEE: e e HEEE: e
Al e gl 203w e e =@ e
[ V. mw

POWER

SUPPLY  NETWORK

INPUT  CONNECTOR DISPLAY OUTPUT CONNECTORS

Full details of connector types, pin-outs and specifications can be found in Section 5: Technical Data.
Briefly, these are as follows:

Power Supply Input

The ImageStar HD requires a 12V power supply via this connector. A suitable mains operated power
supply unit (PSU) is provided.

IMPORTANT: When cycling the mains power to the PSU, wait at least 45 seconds after powering
down before powering up again.

Network Connector

Used for device setup/configuration and downloading new firmware.
USB Connector

Used for downloading new firmware.

Source Input Connectors

Input connectors for up to two analog RGB/component video sources, plus up to two Composite
sources or one S-Video source. See pages 27 to 29 for connection methods.

Display Output Connectors

Output connectors for up to four analog or digital display devices. Each output can be mapped to any
position in a tiled display. See pages 30 and 31 for connection methods.

IMPORTANT: Clip-on Ferrites (e.g. Wiirth part no. 74271132) must be fitted to each output cable as
near as possible to the output connector.

1460GB issue 4 Page 13
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Source Compatibility

Source Types

ImageStar HD provides inputs for up to four sources, which can comprise:

= Up to two analog RGB or component video (YCrCb or YPrPb) sources, plus
= Up to two Composite sources or one S-Video source.

A built-in source switcher is used to select the input to be displayed. This can be operated either by
pressing the SELECT button on the front panel, or using remote commands via the network control
port.

Full auto-detection is provided on each input, allowing a wide range of standard source types to be
connected without the need for any further configuration. For a full list of supported standard modes
see page 80.

NOTE: PAL 60 format is not supported. PAL 60 is commonly output by European VCRs when playing
back an NTSC tape.

Automatic gain control (AGC) ensures optimum source display with signals as low as 20% of normal
amplitude.

NOTE: Due to the dynamic nature of AGC an identical source fed to different inputs may not display
with identical results.

Macrovision-encoded Sources

Many pre-recorded videos and DVD’s are copy-protected by a system called Macrovision®. It works
by inserting variable intensity signals into the non-visible region of the source signal. These ‘false’
signals ‘confuse’ the AGC circuit of conventional recording devices, preventing the source from being
copied satisfactorily.

Typically more than 90% of Macrovision (type 1, 2 or 3) encoded sources can be viewed successfully

using ImageStar HD. However, certain sources may suffer some visual disturbance or fail to achieve
full signal lock.
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Display Capability
ImageStar HD allows any one of the four possible inputs to be scaled up to fill the target display.
Output Channels

The ImageStar HD has four output channels, each capable of driving a wide range of display devices.
Up to four outputs can be driven_with a resolution of up to SXGA (1280 x 1024 pixels). Beyond this
resolution and up to SXGA+ (1408 x1050) or 1080i (1920 x 1080i) up to two outputs can be driven.

For a full list of supported output modes see page 85

Output/Display Mapping

By default, the ImageStar HD output channels are configured to drive a 2x2 target display. However,
any rectangular arrangement of screens can be accommodated by changing the output mapping.

On a single unit, for example, display layouts of 1x2, 1x3, 1x4, 2x1, 3x1 or 4x1 screens are possible.

By using multiple units, the overall size of the target display can be extended to 8x8 screens (or
equivalent rectangular arrangement using up to 64 screens).

Even larger displays are possible but these are difficult to quantify because size limits become
dependant on source and display screen resolutions. Furthermore, an 8x8 target display will require
16 ImageStar HD units to drive it and may not be the most cost-effective solution to driving such a
large display!
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Source Scaling & Viewporting

Typically the selected input source will be scaled to fill the entire target display area. Where the
aspect ratio of the display does not match the aspect ratio of the source, the source will usually be
stretched (either horizontally or vertically) to fit the display.

The following examples show the effect of source scaling on different display layouts:

Original 4:3 Source

Stretched Vertically
for a 1 x 4 Display

Stretched Horizontally
for a 4 x 1 Display

Alternatively, ImageStar HD offers Viewporting capability which allows you to display a specific area
of the source frame. One possible use of this capability is to show specially created source content to
be used on a rectangular display without distortion:

Original
‘Pillarbox’ Source

Viewported
for a 1 x 4 Display

Original
‘Letterbox’ Source

Viewported
for a 4 x 1 Display

Page 16 1460GB issue 4
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Control Capability

Front Panel Control

The SELECT push-button on the front panel provides source selection. Each press will switch to the
next source input. The currently selected source input is shown by the four INPUT indicators (labeled
1to 4).

IR Control
This feature is not currently supported.

Configuration Software

Initial setup and remote control of the ImageStar HD is achieved using the ImageStar HD
Configuration software running on a separate PC or laptop. For further details, see Section 3.

NOTE: For more detailed information about the control protocol used by ImageStar HD and how to
control it via HyperTerminal, refer to Appendix A.

1460GB issue 4 Page 17



Section 1: Introduction IMAGESTAR HD USER GUIDE

Accessories
Supplied Accessories

In addition to this User Guide, the ImageStar HD is supplied with the following accessories. If any of
these items is missing or damaged, please contact your Electrosonic dealer immediately:

ltem Qty Re-order Code

12V Power Supply Unit (PSU) 1 ES5555-PSU

IEC Mains Cord for PSU 1 CA4291LF
(with 3-pin ‘Edison’ plug)

For use in the USA.

IEC Mains Cord for PSU 1 CA429LF
(unterminated)

For use in Europe and all other countries.
See page 25 for plug wiring instructions.

DVI-A to 15-pin HD Adapter 4 CA10026LF

Used to connect 15-pin VGA style
connectors to the DVI outputs.

System Disc 1 M20080

A CD containing user documentation,
support information, firmware files and
configuration software.

Optional Accessories

The following optional accessories are also available for use with the ImageStar HD — these must
be ordered separately from your Electrosonic dealer:

Item Order Code

Rack Mounting Kit ES5555-RM

A Kit that allows an ImageStar HD to be installed in a 19inch
equipment rack. Full instructions are included with the kit.
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Choosing a Suitable Location

The ImageStar HD is designed to be used either as a free-standing unit or (by using the optional kit
available) to be mounted in a 19 inch equipment rack.

CAUTION

Whichever installation method you choose there are certain environmental
requirements, detailed on page 21, which must be observed in order to ensure safe
and reliable operation.

For rack-mounted applications the criteria detailed on page 22, must also be
observed.
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Environmental Requirements

CAUTION

The criteria on this page must be observed for all installations of the ImageStar HD,
whether free-standing or rack-mounted.

Orientation

The ImageStar HD must be operated in the horizontal position only. When used free-standing it must
be placed on a stable, flat and level surface. Ensure that the surface finish will not be affected by the
heat produced by the ImageStar HD when in use.

Temperature

DO NOT install or operate the ImageStar HD in an area where the ambient temperature exceeds
35°C (95°F) or falls below 5°C (35°F).

Remember that, as with all electronic equipment, the ImageStar HD and its associated PSU also
produces heat which may affect the ambient temperature.

After the ImageStar HD has been in use for a period of time the external casing will be very warm to

the touch. While the temperature is well within safe limits please be aware that it may be hotter than
you are expecting. Ensure that any adjacent surfaces will not be affected by the heat.

Ventilation

No special ventilation is required. However, it is recommended that free air circulation is permitted
around the unit.

Humidity & Water

DO NOT install or operate the ImageStar HD in an area in which the ambient relative humidity
exceeds 85% or in an area that is prone to condensation.

DO NOT install or operate the ImageStar HD near water or in a location which may be prone to water
seepage — the ImageStar HD is not waterproof.
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Rack-mount Requirements

CAUTION

For rack-mounted installations, the following criteria must be observed (in addition to
the Environmental Requirements listed on page 21)

Mounting & Support

ALWAYS use the special rack-mount kit (available separately) to secure the ImageStar HD. Full
details on using the kit are included with the kit.

DO NOT stand other units directly on top of the ImageStar HD when it is rack-mounted as this will
place excessive strain on the mounting brackets.

Ventilation

ALWAYS ensure that the rack enclosure is adequately ventilated. Sufficient airflow must be achieved
(by convection or forced-air cooling) to satisfy the ventilation requirements of all items of equipment
installed within the rack.

A ventilation gap of at least 44mm (1U) is recommended above and below the ImageStar HD and
adjacent surfaces or equipment.

Mains Supply

ALWAYS ensure that the mains power supply is of the correct voltage and frequency for all
equipment within the rack, and that it has a good ground/earth connection.

Where a power strip (mains distribution batten) is used (of either a hard-wired or plug and socket

type), always ensure that the current rating of both the power strip and the supply is sufficient for all
equipment within the rack.
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Mains Power Connection (via PSU)

The ImageStar HD must be powered from a 12 Volt DC regulated supply. A suitable mains-operated
power supply unit (PSU) is provided. The mains connection details that follow relate to the PSU.

ff NEVER CONNECT THE /ImageStar HD DIRECTLY TO THE MAINS.

ALWAYS use the PSU provided. If a backup/replacement PSU is required,
always use an Electrosonic approved PSU.

Supply Requirements (for PSU)

ALWAYS observe the following instructions to ensure safe and reliable
operation of the PSU.

ALWAYS ensure that the mains supply voltage is single phase only and is within the permitted range:
e 100 —240V AC (0.45A Max.) 50 — 60Hz.

NEVER connect the PSU to a DC supply.

DO NOT allow the mains power point to be overloaded. This is particularly important to check when

powering several items of equipment from a single power point (e.g. within rack-mounted
installations).

WARNING: To avoid the possible risk of electric shock or product damage due to condensation,
ALWAYS allow the PSU to become acclimatized to ambient temperature and humidity for at least
thirty minutes BEFORE switching on. This is particularly important when moving the unit from a cold
to a warm location.

IMPORTANT: When cycling the mains power to the PSU, wait at least 45 seconds after powering
down before powering up again.

NOTE: The PSU is double-insulated and does not require an earth/ground connection.
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Mains Power Cord (for PSU)

IMAGESTAR HD USER GUIDE

The mains PSU is equipped with a 3-pin (male) type mains connector which requires a power cord
fitted with a corresponding 3-pin IEC320 (female) connector.

Two power cords are supplied with the PSU, each having a different termination; you must use the

lead appropriate for your country:

In... Use the... Re-order Code

USA and Canada cord fitted with the 3-pin CA4291
American-style ‘Edison’ plug.

UK, Europe and all unterminated cord and fit a CA429

other countries

suitable plug as described on
page 25.

WARNING: Do not allow anything to rest on the mains power cord.

Page 24
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Fitting a Mains Plug

If you are fitting a plug to the unterminated power cord (or replacing an existing plug), you must fit a
plug that:

is rated for use with mains voltage

is equipped with a grounding pin/connection

complies with any applicable National or Local electrical regulations

is fitted with a correctly rated fuse (applicable to UK-style plugs only — see page 26.)

WARNING: Never attempt to fit or use a plug without a ground or earth pin/connection.

Wiring Details

The wires of both mains power cords (supplied with each ImageStar HD) are color-coded as shown in
the table below; be sure to connect your plug in accordance with the following guidelines:

Connect the wire to the plug terminal identified
colored... with...
Brown ‘L’ or ‘Live’ or ‘Line’

(or colored red or brown)

Blue ‘N’ or ‘Neutral
(or colored blue or black)

Green & Yellow ‘E’ or ‘E’ or ‘Earth’ or ‘Ground’
(or colored green or green & yellow)

WARNING — If you are unsure of the connections,
or if the markings in your plug do not match those

given above, CONSULT A QUALIFIED ELECTRICIAN.

NOTE: The PSU is double-insulated and does not require an earth/ground connection. However, the
earth cable of the mains lead must be connected in the plug.
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External Supply Protection

The mains power cord supplied with this product is rated at 10A maximum and
must be protected from overload by an external fuse or circuit breaker.

Fused Plugs (UK-style)

If the power cord is fitted with a UK-style BS1363 3-pin plug (i.e. with provision for an internal fuse),
then it must be fitted with a BS1362 ASTA approved 1 inch cartridge fuse.

This fuse must be rated at a maximum of 10A/250V. Since the current draw of the PSU is less than
1A, a fuse of a lower rating not less that 3A/250V may be used.

WARNING: Never attempt to fit a fuse or circuit breaker of a higher maximum rating than shown
above.

Unfused Plugs or Hard-wired

If the power cord is fitted with an unfused plug, or is hard-wired into a power strip (mains distribution
batten), then the power cord must be protected by an external fuse or circuit breaker of a rating shown
in the table below:

Supply Voltage 110V nominal 230V nominal
Maximum Fuse Rating 10A 10A
Minimum Fuse Rating 3A 3A

WARNING: Never attempt to fit a fuse or circuit breaker of a higher
maximum rating than shown above.
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Source Connections

RGB Sources

Section 2: Installation

Component sources (e.g. RGB, YCrCb or YPrPb) can be connected to either input 1 or 2:

RGB Source

RGB Source

NOTE: For pin-out details of the
RGB inputs, see page 52.

E.E?UHDSQI\IG ES5555 ’
www.electrosonic.com ° \- °
12V DC === 1=
REG & OUTPUT 3 4
ON-W IR K
2AMAX <+ove  FE 2 =-ree
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Section 2: Installation

Composite Sources

Composite sources (e.g. CVBS) can be connected to either input 3 or 4

Composite Source

Composite Source

E.E?U’IOSDNIG ES5555 ‘-’ J | = veozo stmso
www.electrosonic.com

K K J a ? L@-vmso @

OUTPUT
E:_ﬁ @ (@ mmmam

12vDC=== 1 C=res 3
REG i
@ 2 . o (E . o HEEEI @ @ HEHE e e M

2AMAX e 24 2 [=rcs o]
|8
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S-Video Source

Section 2: Installation

S-Video sources (e.g. YC) can be connected using input 3 and 4, Luma (Y) to input 3 and Chroma (C)

to input 4:

S-VIDEO Source

ELECEROSONIC ES5555
www.electrosonic.com ) ‘ q i; | &3 vibeo ¢
12vDC==
12v 1 S ree 4 OUTPUT
@ o il - e mm o o <
2AMAX e 2 2 S en 7
Vmw

g VIDEO Y
[ svioeo
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Display Connections

Digital Displays

Connect analog display devices to the outputs using suitable DVI-D type connectors and cables.
The diagram below shows the default output mapping for a 2x2 target display:

ELECEROSONIC ES5555 - wj'?: S vioeo -
www.electrosonic.com ‘
4 E-vmso c

12vpCI== 1 Sres

REG 2 OUTPUT 3 4
@ 2 - o [ - o HHEN: @ @ HEHEI: o e HENNI: @ @ HHI: e
2AMAX  <ore 25 2 Fres | J

IR J w

IMPORTANT:

Clip-on Ferrites (e.g. Wiirth part no. 74271132)
must be fitted to each output cable as close

as possible to the output connector.

Digital
DINF\Y
Devices

NOTE: For pin-out details of the
DVI-I outputs, see page 53.
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Analog Displays

Connect analog display devices to the outputs using suitable DVI-A type connectors and cables.

NOTE: 15-pin RGB type connectors and cables can also be used with DVI-A to 15-pin adapters as
shown below. However, this method may prevent ‘wide’ modes (e.g. WXGA) from displaying correctly.

The diagram below shows the default output mapping for a 2x2 target display:

e~ 1 Goros OUTPUT 3 4

REG
@ QN - o HEHHIN @ @ EEEEE e e i
2AMAX  <ye 2 2 Sres | |
Ik

ELECGROSONIC ES5555 \ 3 EV'DEOEVSWDEO
www.electrosonic.com Y ‘- [ ] 4 [E_vmgo c

3 e e HEIEL: e

DVI-Ato
15 pin HD-type
Adapters

IMPORTANT:

Clip-on Ferrites (e.g. Wiirth part no. 74271132)
must be fitted to each output cable as close

as possible to the output connector.

Analog
Display
Devices

NOTE: For pin-out details of the
DVI-1 outputs, see page 53.
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SECTION 3:

Configuration
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Section 3: Configuration IMAGESTAR HD USER GUIDE

Introduction & Overview

ImageStar HD Configuration is a Windows software application that is used to configure the inputs
and outputs of the ImageStar HD image processor.

NOTE: For more detailed information about the control protocol used by ImageStar HD and how to
control it via HyperTerminal, refer to Appendix A.

Installing the ImageStar HD Configuration Software

ImageStar HD Configuration can be installed on any suitable PC or laptop provided that the following
minimum requirements are met:

Operating System: Windows XP (service pack 2) with .NET framework

Network Port: Ethernet 10Mbps or higher
Free Disk Space: At least 10MB
Optical Drive: CD-ROM compatible

The application installer is located on the ImageStar HD System Disc. Insert the disc into the optical
drive on your PC or laptop and wait for the disc browser to run automatically. If the browser doesn’t
run, or you have disc auto play disabled, run the setup.exe file located on the root of the System Disc.

Follow the onscreen instructions to perform the installation.

Starting the Application

Once ImageStar HD Configuration has been installed it can be run from the main start menu:

1> Click on Start | All Programs | Electrosonic | ImageStar HD Configuration
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Overview of the Workspace

After starting ImageStar HD Configuration you will be presented with an application window similar to
the following example:

&5, ImageStar HD Configuration:Untitled3.ica |Z”E”z‘
File  Window Help  Edit  Layout

BEICL B2 [n]

i Network B@g] =, Wall Layout |Z”§”gl

Local Hame | Name IP Status i

il
0
Ed)<

i Imagestar HD Devices

Ready | YGA (640x480) S0H2 IScrEens:Pﬂintar

Windows
The application has three main working areas or windows:

¢ Network Window: used to manage ImageStar HD devices on the network, including the
setting-up of network communications (IP Address, etc).

e ImageStar HD Devices Window: used to configure and select inputs on ImageStar HD
devices and assign devices to clips.

e Wall Layout Window: used to configure the target display for your ImageStar HD system.

A fourth window — the ImageStar HD Discovery Window (accessible via the Window menu) is used
to find or ‘discover’ ImageStar HD devices connected to the network.
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Menu Bar
File  window Help  Edit  Layout

The menu bar provides access to various functions. The basic File, Window and Help menus are
always available and these are supplemented with additional context-sensitive menus according to
which one of the three windows is currently selected:

e Edit and Layout menus for the Wall Layout Window,

e Network menu for the Network Window,

e Devices menu for the ImageStar HD Devices Window, and

e Discovery menu for the ImageStar HD Discovery Window.
Toolbar

2200 BR L2 n ]

The toolbar is used in conjunction with the Wall Layout Window when creating wall layouts.

Status Bar
Ready | #E8 (1024x768) 50Hz | Screens:Pointer

The status bar shows various pieces of information about the status of the application.
From left to right, these are:

General operation or connection status (e.g.):
Ready
Connecting...please wait
Discovering...please wait
The current output format selected (e.g.):
XGA (1024x768) 50Hz
The current mouse control state for the Wall Layout Window (e.g.)
Screens:Pointer
Screens:Screen

Clips:Pointer
Clips:Clip
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Example Layout

The following view shows an example of ImageStar HD Configuration in use and gives an indication
of what you can expect to see in each window:

15: ImageStar HD Configuration:MySetup.ica * |z”§”zl

File  Window Help  Devices

3 Network.

LocalMame | Mame IP Status B SHD g [

ISHD Devicel ModeMame 172.28.230.140 Not oo FSHD Deviced IQSHD Devicel::

.
ISHD Deviced i

&5, Imagestar HD Devices |Z||E||z‘

[ futodetect v| [SeparsteHandy v [vEth v [Inputt

Macefame
| Butodetect v| SepasteHandv v |[voip v [Inpu2 8
i L

[Autodstect v | v | [inputz mm
|Autndatect Vl ‘ Vl | b | ‘|I’1DUl4 ISHD Devicel

Ready | G {1024x768) S0Hz | Screens:Painter

Reorganising the Workspace Layout

Each time ImageStar HD Configuration is started it will show the default window arrangement.
However, you can resize, reposition, show or hide windows to suit your preferred working style.

To return to the original default window arrangement...

1z Click the Window menu and choose Arrange.
To hide or show particular windows...

i Click the Window menu and choose the required window by name. A check mark next to the
window name indicates that it is visible; no check mark means it is hidden.
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Saving and Opening Configuration Files

The settings that you define in ImageStar Configuration can be saved as a configuration file. This
allows you to keep a safe backup of the ImageStar HD setup and to build-up a library of useful
configurations which can opened when needed.

Configuration files are saved with a .ica file extension.

To Save a Configuration File...

1> Click the File menu and choose Save (to a copy of the current setup file) or Save As (to
create a copy of the current file under a new name).

Choosing Save As (or Save on an ‘untitled’ setup) will display the
standard Windows Save As dialog:

Save As E]@
Sawvein | |3 ImageStar HD Configuration &pplication V. o ¥ > m'

hy | 5ample Layouts

My Recent
Documents

Desktop

My Documents

by Computer
3
My Metwork | Savesstoper | ica fles [ica) v

1> Choose the required location for the file and type an appropriate File name.

i Click the Save button.
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To Load an Existing Configuration File...
i Click the File menu and choose Open.

The standard Windows Open dialog will appear:

Laak jn |l;) Imagestar HD Configuration Application v| €} T E-
Y Iy 5ample Layouts
:3 |_=] My Setup.ica
My Recent
Documents
=
L
Desktop
iy Documents
My Computer
‘;:‘] File name:; |M5JS etup.ica b ‘ [ Open 1
N ] . 1
My Metwork | Files of type: | ica files [%ica) v | [ Cancel ]

HINT: Some sample configuration files are provided with ImageStar Configuration and these
can be found in the Sample Layouts folder.

1 Locate the required configuration file.

i Click the Open button.
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Using ImageStar HD on a Network

In normal standalone operation, the ImageStar HD does not require a network connection.

However, to configure the unit, it is necessary to connect a PC/laptop (running the ISC App software)
to the device via its Ethernet port.

This can be achieved either by:

e Adirect connection between the PC and the ImageStar HD using a CAT5 crossover cable, or
e Anindirect connection via a network.

Direct Connection (via crossover cable)

CONFIG
PC

Indirect Connection (via local area network)

CONFIG

Whichever method is used, the network settings of the PC must be compatible with the ImageStar
HD, i.e. both devices must have the same Subnet Mask.

The ImageStar HD is shipped with the following default network settings:

IP Address: 192.168.0.65
Subnet Mask: 255.255.255.0

This enables the device to be connected directly to a Class C type network using IP Addresses in the
range 192.168.0.XXX provided that no other device is presently allocated the address 192.18.0.65.

Therefore, the PC must have the settings:

IP Address: 192.168.0.XXX (where XXX is in the range 1 thru 254, but not 65)
Subnet Mask: 255.255.255.0
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Rebooting the ImageStar HD

In certain circumstances it will be necessary to reboot the ImageStar HD to ensure that new settings
are correctly implemented. For example:

e When changing network settings.
e When change the output resolution to or from SXGA+.

IMPORTANT NOTE: The control connection established between an ImageStar HD and ImageStar
Configuration is not maintained following a reboot operation. Therefore, you will need to ‘disconnect’
then ‘reconnect’ to the device to restore the connection.
To reboot the unit...

1> Ensure that ImageStar Configuration is ‘disconnected’ from the unit to be rebooted.

1> Disconnect the power to the unit.

1> Wait for at least 45 seconds and then reconnect the power.

The unit will then go through its initialisation/self-test phase (approx. 30 seconds). Once this is
complete, you can ‘connect’ to the unit again if required.
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Using ImageStar HD Configuration

The remaining pages in this section contain various procedures for creating a configuration for
ImageStar HD.

Set up falls broadly into four stages:

e Setting-up Network Communications (page 43 onwards)
How to change network settings (IP Address, etc)

e Setting-up the Source Inputs (see page 50)
How to define input modes and select an input to display

e Setting-up the Display Outputs (see page 51 onwards)
How to define the output mode, screen arrangement, source scaling and positioning

¢ Fine-tuning the ImageStar HD (see page 59 onwards)
How to adjust RGB inputs, screen overscan and offsets

Page 42 1460GB issue 4



IMAGESTAR HD USER GUIDE Section 3: Configuration

Setting-up Network Communications

Adding ImageStar HD Devices

If the PC or laptop running ImageStar HD Configuration is connected to the same network as an
ImageStar HD processor, use the Discovery function as described below to find it and add it to the list
of devices.

If you are working ‘offline’ you can add an ImageStar HD device manually (see page 45).

To add a device using the Discovery Function...
1z Click the Window menu and choose ImageStar HD Discovery.

The ImageStar HD Discovery window will open:

1i. Imagestar HD Discovery EJ@|E|

1 Click the Discovery menu and choose Discover to check for active ImageStar HD devices
on the network.

Any devices found will be listed by their current IP Address:

2i. Imagestar HD Discovery EJE|E|

0,140
2,68

172.20.23

1> Click on a device IP Address to highlight it.

i Click the Discovery menu and choose Add to Network.
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A new device entry will appear in both the Network and ImageStar HD Devices windows:

&=, ImageStar HD Configuration:Lintitled5.ica *

Nebwork.

File  “Window  Help

EEEED

EJEJX) & WallLayout

17228230140 Mot cornected

.- Imagestar HD Devir~-

> v| |Separate H and® - | |YCer V‘ |\npuﬂ ‘ |F|GB v‘ 1 O L]

|Autodetect V| |Separate H and b | |Y’ErEb v‘ |\nput2 ‘ |HGB v‘ 2 O FE 2

|Autndetect vl | v|| v‘ |\nput3 ‘ |EVBS v‘ 3 O O s
utodetect vl | "H v‘ |\nput4 ‘ |WBS v‘ 4 O ]

\

i If you need to change the device name or IP settings for this device, please refer to ‘Changing
Network Settings for a Device’ on page 46.

IMPORTANT: Remember that in order to communicate with an ImageStar HD device, it
must be on the same subnet as the control PC/laptop (see page 40).

Otherwise, you can now move on to ‘Setting-up ImageStar HD Inputs’ on page 50.

HINT: By activating Link Selection in the Window menu, selecting a device in either the
Network or ImageStar HD Devices windows will automatically select/highlight the
corresponding device entry in the other window.
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To add a device manually...
i Click the Network window.
1z Click the Network menu and choose Add.
The ImageStar HD Node dialog box will appear:

Imagestar HD Node

Lacal name | [l LT

Mode® 0 |0 [jo |0 |

Subnet (0 |0 [0 |0 |

Fateway |D ||D ||D ||D |
[ (]9 ] [ Cancel ]

1z If required, change the Local name label to something more meaningful.
NOTE: The Node name currently serves no purpose and can be ignored.
1> Enter a suitable Node IP address and Subnet mask for the device.
NOTE: The Gateway address currently serves no purpose and can be left as zeros.

1> When the details are correct, click OK.

A new device entry will appear in both the Network and ImageStar HD Devices windows.

&, ImageStar HD Configuration:Untitled5.ica *

eeeee

i If you need to change the device name or IP settings for this device, please refer to ‘Changing
Network Settings for a Device’ on page 46.

IMPORTANT: Remember that in order to communicate with an ImageStar HD device, it
must be on the same subnet as the control PC/laptop (see page 40).

Otherwise, you can now move on to ‘Setting-up ImageStar HD Inputs’ on page 50.
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Changing Network Settings for a Device

1 In the Network window, double-click the Local Name of the required device.
The ImageStar HD Node dialog box will appear:

Imagestar HD Node

Local name | [l RN RERT=EY
Node nane

NodelP (172 | |28 | |230 | 140 |

Subnet (255 | (255 [[o |0 |
Gateway |EI ||EI ||D ||EI |
[ ok ] [ Cancel ]

i If required, change the Local name label to something more meaningful.

NOTE: The Node name currently serves no purpose and can be ignored.
1> Enter a suitable Node IP address and Subnet mask for the device.

NOTE: The Gateway address currently serves no purpose and can be left as zeros.
i When the details are correct, click OK.

IMPORTANT: You will need to ‘connect’ to the device and ‘update’ it for the new network
settings to take effect (see page 47).

Removing a Device

1z In the Network window, click the Local Name of the required device.

25» Configuration Network E|@|g|

LocalMame = Mame IP Status

E@ ModeMame 17228230140 Mot connected

i Click the Network menu and choose Remove.

Page 46 1460GB issue 4



IMAGESTAR HD USER GUIDE Section 3: Configuration

Updating an ImageStar HD (Network Settings)

Any changes that you make to the network settings in ImageStar HD Configuration are not
automatically sent to the actual ImageStar HD device. To implement any new settings you must first
‘connect’ to the device and then ‘update’ it.

To connect to an ImageStar HD...

i In the Network window, click the Local Name of the required device.

2 (=1

Local Mame  Mame IP Statuz

EWNDEIBNEMB 172.28.230140 Mot connected

1> Click the Network menu and choose Connect (or Connect All to connect all devices at once).
The Status of the device will now show Connected:

5. Network ~BIX]
Local Mame  Mame IP Status ez
15 R ModeMame  172.28.230.140  Connected  Firre

NOTE: If the connection attempt fails for any reason, the following message will appear:

Failed to open the command interface

To disconnect from an ImageStar HD...

i In the Network window, click the Local Name of the required device:

22: Metwork |:| |E| Bl

Local Mame  Mame IP Status Werg

W ModeMame 172.28.230140 Connected  Firmw

i Click the Network menu and choose Disconnect (or Disconnect All to disconnect from all
devices at once).

The Status of the device will now show Not connected:

NOTE: If the following message appears it indicates that the device was already
disconnected:

Mode does not have a command interface
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To update the Network Settings of an ImageStar HD...
1z In the Network window, click the Local Name of the required device.
1> Click the Network menu and choose Update.

The Commands dialog will appear, showing a list of commands that will be sent to the
ImageStar HD device:

IPADDSet=172,28,230,140,0,0
MASKSet=255,255,0,0,0.0
GatewaySet=0,0,0,0,0.0
SaveMetwork=0.0,0,0,00

Coc ] [ow]

If required, you can prevent a command from being sent by deselecting the checkbox next to
the command line.

HINT: Clicking the Export button saves the ‘checked’ commands into a text file.
1 To send the selected commands, click OK.

The following message will appear:

Warning

1 Click OK and, when you are ready to do so, reboot the device (see page 41).

IMPORTANT NOTE: Remember that the control connection established between ImageStar
Configuration and the ImageStar HD is not maintained following a reboot operation. Therefore,
you will need to ‘disconnect’ then ‘reconnect’ to the device to restore the connection.
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Using the Identify Function

The Identify function causes the red source LEDs on the front of the ImageStar HD to flash briefly.
In a multi-processor system this can be used to help identify which device is which.

IMPORTANT: All current wall layout and clip settings will be cleared from the ImageStar HD.
These settings will need to be reapplied following use of the Identify function.

i In the Network window, click the Local Name of the required device.
1 Click the Network menu and choose Identify.

The red source LEDs on the front of the corresponding ImageStar HD will switch to input 1
(for 3 seconds) then to input 2 (for 3 seconds) and finally back to input 1.
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Setting-up the Source Inputs

IMAGESTAR HD USER GUIDE

i In the ImageStar HD Devices window, choose the required settings for one or more inputs,
using the drop-down boxes:

2=, Imagestar HD Devices

|Autudetect w ‘ | Separate H and vV

hlodehlame

[ autodstect | [Separate H and v

[ futodstect v [

| Autodetect v |

O00E

ISHD Dewicel

e

=

WM W

Typically, the default input mode of Autodetect is recommended. This allows the
ImageStar HD to choose the input format that best matches the source.

1> Ensure that the required input is selected by choosing the corresponding checkbox (1 to 4).

Page 50

NOTE: The checkboxes on the right-hand side are reserved for future use and currently

should be left unchecked.
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Setting-up the Display Outputs

Setting the Output Mode

Setting the Output Mode determines the signal type that the ImageStar HD outputs to the display
devices. It also defines the size/resolution of the screen icons in the Wall Layout window.

1 Click on the Wall Layout window to highlight it.
1 Click the Layout menu and choose Set Resolution.

The Screen Resolution dialog will appear:

DOutput mode

HGA [10244768) B0Hz w
GenlLock

dizabled w
Owverscan

H |0 E- Yo|o £
HZ(0.0 A Wx|0o A

[ ] ] [ Cancel ]

1> Select the appropriate Output mode for driving your display devices.
i If required, choose GenLock mode and specify any Overscan settings.
HINT: Overscan settings can also be adjusted interactively (see page 60).

i Click the OK button.
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Adding Screens to the Wall Layout

The Wall Layout provides a representation of the target display. One screen is required for each
display device in the target display and these must be positioned and aligned to match the real

display.

IS8

=8

IS8

IS

Page 52

m[m}
Click the BO button to select the Screen Layer.

oo
Click the O+ button to select Add Screen mode.

Click in the Wall Layout window — each click will add a new screen to the layout.

2. Wall Layout

To turn off Add Screen mode, click the a3 button.

Move each screen into the required position by dragging it with the mouse or by using the
keyboard arrow keys.

NOTE: The arrow keys move the screen in increments of 10 pixels.

To delete a screen from the layout, click on it and press the Delete key (or choose Delete
from the Edit menu).

To precisely adjust a screen position, double click a screen to open its Properties dialog (or
choose Properties from the Edit menu).

Left

Width | 1024 Height | 768
Right | 1023 Bottom | 767

[ 0K ] [ Cahcel ]

Top

AL

Adjust the Top and Left pixel coordinates as required, and click OK.

NOTE: Pixel coordinates are measured from the extreme top left corner of the Wall Layout
window, i.e. Top=0, Left=0. Pixel coordinates sent to the ImageStar HD are relative to
the top-left corner of the associated source clip.

Click the OK button.
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Add a Clip

A clip defines the area or window that the source input occupies on the target display. For example, if

your target display is arrange as 2x2 screens, typically the clip will be sized so that it fills the entire
display.

i Click the D button to select the Clip Layer.

i Click the D button to select Add Clip mode.

i Click in the Wall Layout window — each click will add a new clip to the layout.

5. Wall Layout

i To turn off Add Clip mode, click the k button.
1z Move or resize the clip into the required position by simply clicking and dragging the handles.
NOTE: The arrow keys can also be used to move the clip in increments of 10 pixels.

1> To delete a clip from the layout, click on it and press the Delete key (or choose Delete from
the Edit menu).

iz To precisely adjust the position of a clip, double click the clip to open its Properties dialog (or
choose Properties from the Edit menu).

p

Wit Height |1520

Right Bnttam
[ 0K ] [ Cahcel ]

1z Adjust the Top and Left pixel coordinates to alter the position and Height and Width values
to alter the size, and click OK.

NOTE: Pixel coordinates are measured from the extreme top left corner of the Wall Layout
window, i.e. Top=0, Left=0.

iz Click the OK button.
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Assign Screens to ImageStar Outputs

Each screen in the Wall Layout must be assigned to one of the ImageStar HD outputs.

1z Click on the Wall Layout window.

oo
i Click the BO button to select the Screen Layer.

1> Click on a screen to highlight it (thick blue outline):

= Wall Layout

1
1 2
.

i Click the Layout menu and choose Assign screen to output.

The Object Mapping dialog will appear:

Object Mapping

Screen Output

to | 15HD Devicel:1
ISHD Devicel:2
ISHD Devicel:3
ISHD Devicel:4

[ Ok ] [ Cancel ]

1 In the Output column, click on the device output that will be used to drive the selected
Screen.

i Click the OK button.

The Wall Layout will now show the output assigned to the screen:

== Wall Layout

(N =HD Device:

1> Repeat this process for each screen in the Wall Layout.
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Assign an ImageStar to a Clip

Each clip in the Wall Layout needs to be assigned to one of the ImageStar HD devices, to allow the

clip to show an input source.

i In the ImageStar HD Devices window click on the ImageStar icon to highlight it (thick red

outline):

2=, Imagestar HD Devices

|Autudetect

w ‘ | Separate H and vV

v| |Input1

|Autndetect

| [Separate H and v

v| |Input2

|Autndetect

# |

v| |Input3

|Autndetect

# |

v| |Input4

i Click the Devices menu and choose Assign device to clip.

The Object Mapping dialog will appear:

Object Mapping

Device

Clip

o [

Ok ] [ Cancel

i Click the OK button to confirm the assignment.

The Wall Layout will now show the device assigned to the clip:

22 Wall Layout

1:15HD Deviced

!
MEHE De vide] "2

3
ISAD Dieviced . 3

4
ISHE: Device 4
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Assign Screens to a Clip

Each screen in the Wall Layout needs to be assigned to a clip, to allow it to display the corresponding
portion of the clip.

1=y

Page 56

Click on the Wall Layout window.

oo
Click the BO button to select the Screen Layer.

Click on a screen to highlight it (thick blue outline):

2. Wall | ayout

:II:ISI—“"I Device

ISHD Device
a

3

ISHD Device ISHD Device

ISHD Device

2
4

Click the Layout menu and choose Assign screen to clip.

The Object Mapping dialog will appear:

Object Mapping

Screen Clip
to
[ aK ] [ Cancel

Click the OK button.

The Wall Layout will now show the screen assigned to the clip:

2. Wall Layourt

1 L il J/

1
ISHD Device: IZHD Device

E 4
ISHD Device ISHD Device

IMAGESTAR HD USER GUIDE

1460GB issue 4



IMAGESTAR HD USER GUIDE Section 3: Configuration

Updating an ImageStar HD (Input/Output Settings)

Any changes that you make to the network settings in ImageStar HD Configuration are not
automatically sent to the actual ImageStar HD device. To implement any new settings you must first
‘connect’ to the device and then ‘update’ it.

To connect to an ImageStar HD...

i In the Network window, click the Local Name of the required device.

H=1[E3
LocalMame  Mame IP Stabus

@Noder\lame 17228230140 Mot connected

1> Click the Network menu and choose Connect (or Connect All to connect all devices at once).

The Status of the device will now show Connected:

2. Metwork |Z| |E| El

LocalMame  Mame IP Status Yerz
(SIS EREEWE ModeMame 17228230740 Coneectad  Firrme

NOTE: If the connection attempt fails for any reason, the following message will appear:

Failed ko open the command interface

To disconnect from an ImageStar HD...

1 In the Network window, click the Local Name of the required device:

- (=1

Local Mame  Mame IP Statuz Wers

m MWodeMame 17228230140 Connected  Firme

1> Click the Network menu and choose Disconnect (or Disconnect All to disconnect from all
devices at once).

The Status of the device will now show Not connected:

NOTE: If the following message appears it indicates that the device was already
disconnected:

Mode does not have a command interface
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To update the Input/Output Settings of an ImageStar HD...

i In the ImageStar HD Devices window click on the ImageStar icon to highlight it (thick red
outline):

2=, Imagestar HD Devices

iAuthEtect v‘ |Separate HandV Vl |YEer VI |Input1 | |RGE V‘ 1 Nodetlame O
[ autodstect v| [SeparateHondv | [vems v |[mewz | [REE v 2 O 3 O 2
!Autndstect v! | ~| | v! |Input3 | |[,VES v‘ 3 O o o e 0O 3
| autodstect v | v| | [Inpues | fows #]4 O ISHD Devicet O «

i Click the Devices menu and choose Update.

The Commands dialog will appear, showing a list of commands that will be sent to the
ImageStar HD device:

Sethutodet=0.0,0,0.0.0
SetOptdode=4.0,0,0,0,0
Set05can=0,0,0.0.0.0
Settdap=0.0,0,1024 7680
SetMap=1.1034,0.1024 763.0
Sethap=2,0,768,1024,768,0
Settdap=3,1024, 768,1024 7680
SetClip=0,0,0,2043,1525.0
SetOffset=0,0,0,0,0,0
Set0ffzet=1,0,0,00,0
SetOffset=2,0,0,0,00
SetDffset=3,0,0,0,0,0

ok, l [ Cancel

HINT: If required, you can prevent a command from being sent by deselecting the checkbox
next to the command line. You can also save the command list as a text file by clicking
the Export button.

1> To send the selected commands, click OK.

The following message will appear:

Warning

Commands sent ta the device. You may need to reboaot the Imagestar if the cutput mode was changed

NOTE: A reboot is only necessary when changing the Output Format to or from SXGA+.
1> Click OK and, if necessary, reboot the device (see page 41).
IMPORTANT NOTE: Remember that the control connection established between ImageStar

Configuration and the ImageStar HD is not maintained following a reboot operation. Therefore,
you will need to ‘disconnect’ then ‘reconnect’ to the device to restore the connection.
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Fine-tuning the ImageStar HD (Interactive Settings)

ImageStar HD Configuration allows various settings to be adjusted or fine-tuned while connected to
an ImageStar HD device:

¢ RGB Inputs — including brightness, contrast and active video alignment.

¢ Display Overscan
e Display Offset

Adjusting RGB Inputs

Some RGB sources may require some manual fine-tuning to achieve the best possible image on the
target display. ImageStar HD provides control of various input parameters including brightness,
contrast, active video alignment and clock phase.

1> Ensure that the ImageStar HD is currently connected (see page 57).

i In the ImageStar HD Devices window click on the ImageStar icon to highlight it (thick red
outline):

2=, Imagestar HD Devices

EAuthEtect vi iSeparateH andV Vi YOCh v | ilnDuH | |RGE | 1 Nodetlame O
[ sutodstect v [SepaateHandv | [vos | [Inpuz | [ree =2 O : e W O =
! | : i lre_ B

[antodetect v | ~| | | [Inputa | Joves &2 O = 0O s
[Avtodetect v | v| | [Inpues | fows #]4 O ISHD Devicel O a4

i Click the Devices menu and choose Interactive Inputs.

The Interactive Inputs dialog will appear:

Interactive Inputs

Input Step size
b & [ °l

contrast

brightress

harizontal start

vertical start

pixels per lineg

~
"

phaze

1z Select the required Input.

i Click the buttons to increase a value, or the buttons to decrease a value,

by the amount specified by the Step size.
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Setting the Correct Overscan

1 Ensure that the ImageStar HD is currently connected (see page 57).
1z Click on the Wall Layout window to highlight it.
1z Click the Layout menu and choose Set overscan.

The Interactive Overscan dialog will appear:

22 Interactive Overscan

T
o
f=
=
4
=
o
=
]
4
-
=%
=1

1> Adjust either the absolute values H and V or percentage values H% and V% as required,
using the spin controls or by typing a value directly into a field.

For example, if the display devices have an overscan of 7%, set both H% and V% to 7.
1z Click Send to update the display with the new settings.
HINT: By selecting the Auto checkbox, each click of the spin controls will update the target

display without needing to click Send. This is useful for making small adjustments.
Typing a value and pressing the Enter key will also update the display immediately.
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Adjusting Screen Offsets

1> Ensure that the ImageStar HD is currently connected (see page 57).

i In the ImageStar HD Devices window click on the ImageStar icon to highlight it (thick red
outline):

2=, Imagestar HD Devices

|Autudetect v‘ |Separate HandV Vl |YEer V| |Input1 | |F|GB V‘ 1 Nodetlame O
[ autodstect v| [SeparateHondv | [vems v |[mewz | [REE v 2 O e o 0 -
|Autndstect v‘ | v|| ~| |Input3 | |[,VES v‘ 3 M o - S === 0O 3
[avtodetect v | v | [Inpues | [oes ¥4 O ISHD Devicel O s«

i Click the Devices menu and choose Interactive Outputs.

The Interactive Outputs dialog will appear:

Interactive Outputs |Z”E|[gl
Dutput offsets ] Auto
H W
i o 3 [0 & [ send ]
2 o 3 ¢ [send ]
3l 3 [0 & [ 5ens |
s o 3 [0 S [send ]

Note that separate H and V values can be specified for each output (1 thru 4).

1> Use the spin controls to set the required offsets or type a value directly into the appropriate
field.

i Click the corresponding Send button(s) to update the display with the new settings.
HINT: By selecting the Auto checkbox, each click of the spin controls will update the target

display without needing to click Send. This is useful for making small adjustments.
Typing a value and pressing the Enter key will also update the display immediately.
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Restoring Default Settings

An ImageStar HD can be returned to its default factory setup by using the Set Defaults function. All
current settings will be lost.

The default settings are:

e Output Mode: XGA 60Hz (mode 5) no genlock
e Screen Map: 2x2 XGA with no over/underscan or offset
e Source Clip: 2x2 XGA from current graphics source

To restore the Default Settings...

i In the ImageStar HD Devices window click on the ImageStar icon to highlight it (thick red
outline):

22. Imagestar HD Devices

EAUlDdElEC[ vi ISeparalE HandV vi YOCh v [Inputt | | RGE | Nodehiame B 4
IAuthatect Vi |Separata HandV v |YCiCh Vi |Inputz | |RGE ﬂ - O e 3 7": | -
[ Autodetact v | v v| [Inputs | foves ~[ a2 O I O 3
| Autodatect "1 | VI | Vi |Inputd | | CvBs V! 4 O ISHD Devicel O a

i Click the Devices menu and choose Set Defaults.

The Commands dialog will appear, showing the SetDefaults command string:

SetDefaults=0,0,0.0,0,0

Cod (o]

1> To send the command, click OK. Remember that all current settings will be lost.

The following message will appear:

Warning

NOTE: A reboot is only necessary when changing the Output Format to or from SXGA+.
1> Click OK and, if necessary, reboot the device (see page 41).
IMPORTANT NOTE: Remember that the control connection established between ImageStar

Configuration and the ImageStar HD is not maintained following a reboot operation. Therefore,
you will need to ‘disconnect’ then ‘reconnect’ to the device to restore the connection.
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Mechanical Data

Overall Dimensions:  Width: 293mm (11.55 inches)
Depth: ~ 185mm (7.30 inches) [including rear sockets]
Height:  44mm (1.75 inches) [excluding rubber feet]
47mm (1.85 inches) [including rubber feet]
Average Weight: 0.65 kg (1.45 Ibs)

Operating Conditions
Ambient Temperature: 5°C to 35°C (41 °F to 95°F).

Ambient Humidity: 85% maximum (non-condensing).
Location: Free-standing or 19” Rack-mounting (using approved Kit).

Power Supply

ImageStar HD
Supply Voltage: 12V DC Regulated.
Supply Current:  2.0A max.

PSU
Supply Voltage: 100 — 240V AC nominal.
Supply Frequency: 50— 60 Hz nominal.
Supply Current:  0.45A maximum.
Supply Inlet Connector: IEC320 (C14)
Supply Mating Connector: |IEC320 (C13); suitable 2m (6ft) mains cord supplied.
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Section 4: Technical Data

Control Inputs/Outputs

USB Connector

Function:
Connector Type:
Pin-out Details:

Mating Connector:
Recommended Cable:
Maximum Cable Length:
Comms Standard:

Network Connector

Function:
Connector Type:
Pin-out Details:

Mating Connector:
Recommended Cable:
Max. Cable Length:
Comms Standard:
Default IP Address:

1460GB issue 4

Downloading new firmware.
USB type ‘B’ Socket.

(view into socket)

Pin Function
1 +5V

2 Data —
3 Data +
4 Ground

USB type ‘B’ Plug with metal cover.
USB Cable.

5 metres (16 feet).

USB 2.0.

Device setup and for downloading new firmware.
Shielded RJ-45 Socket.

Shield/Screen Shield/Screen

(View into socket)

87654321

Pin Function Pin Function

1 TX D1+ (TX+) 5 Bl D3—

2 TX_D1—(TX=) 6 RX_D2- (RX-)
3 RX_D2+ (RX+) 7 Bl D4+

4 Bl D3+ 8 Bl D4—

Shielded RJ-45 Plug.

Shielded twisted pair (STP).

100 metres (330 feet).
10/100BASE-T (Fast Ethernet)
Factory-set to 172.28.232.65.
User-definable via control software.
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Source Inputs

RGB Inputs

Function: Two connectors labeled as 1 and 2, allowing up to two analog
component video/graphics sources to be connected.
Connector Type: 15-pin High Density D-type.
Pin-out Details:

(View into socket)

Connector Shell = Screen

Pin | Function Pin | Function Pin | Function

1 Red 6 Gnd (Red) 11 | Ground

2 Green 7 Gnd (Green) 12 | DDC Data
3 Blue 8 Gnd (Blue) 13 | HSync

4 NC 9 +5V Input 14 | V Sync

5 Ground 10 | Gnd (Sync) 15 | DDC Clock

Mating Connector:  15-pin High Density D-type.
Recommended Cable: SVGA Monitor Cable (overall screen).
Maximum Cable Length: 2.95 metres (9.5 feet)
Signal Type: Component YCrCb, YPrPb, RGB.
Pixel Clock: 10MHz — 165MHz.
Resolution:  Graphics: Up to 1600 x 1200 pixels (UXGA).
Video: 525i, 625i, 720p, 1080i, 1080p.
Video Level: 0.7V
RGB Sync Modes: RGsB (sync on green);
RGBS (composite sync);
RGBHYV (separate H & V sync).
Sync Level: 0.3V into 75Q (RGsB, RGBS, YCrCb, YPrPb);
2.0V minimum into 2.2KQ (RGBHV).
Scan Mode: Interlaced (for video sources);
Progressive (for graphics sources).
De-Interlace Mode: 1i (‘bob’ / single field interpolated)

VIDEO Inputs

Function: Two connectors labeled 3 and 4, allowing up to two composite sources
to be connected, or one S-Video using input 3 for luma (Y) and input 4
for chroma (C).
Connector Type: BNC.

Signal Type: CVBS or YC.
PAL (B,D,G,H,I,M,N,Nc)
NTSC (J,M,4.43)
SECAM (B,D,G,K,K1,L)

Input Setup: Auto detect.

De-Interlace Mode: 1i (‘bob’ / single field interpolated)
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Display Outputs

Function: Final scaled analog or digital output to the target display, labeled
OUTPUT 1, 2, 3 and 4. Up to four display devices are supported,
depending on output resolution

Card Weight:  0.29 kg (0.63 Ib).
Connector Type: DVI-I (female).
Pin-out Details:

(View into socket)

Connector Shell = Screen

Digital Connections

Pin | Function Pin | Function Pin | Function
1 TMDS 2- 9 TMDS 1- 17 | TMDS 0-
2 TMDS 2+ 10 | TMDS 1+ 18 | TMDS 0+
3 Ground (2/4) 11 Ground (1/3) 19 | Ground (0/5)
4 No connection 12 No connection 20 No connection
5 No connection 13 No connection 21 No connection
6 DDC Clock 14 | +5V supply* 22 | Ground (CIk)
7 DDC Data 15 | Ground (for 5v) 23 | TMDS Clock+
8 | Analog V-Sync | 16 | Hot Plug Detect 24 | TMDS Clock-

*5V on pin 14 limited to 100mA by thermal fuse on each output.

Analog Connections

Pin | Function

C1 | Red Signal

C2 | Green Signal
C3 | Blue Signal

C4 | Horizontal Sync
C5 | Ground

NOTE: Analog Vertical
Sync is on pin 8.

Mating Connector: DVI-D, DVI-A or DVI-I (male).
Recommended Cable: Digital: DVI Single or Dual Link Digital Video Cable;
Analog: DVI Analog Video Cable.
Max. Cable Length: Digital: 5 metres (16 feet);
Analog: 10 metres (32 feet).

IMPORTANT: Clip-on Ferrites (e.g. Wiirth part no. 74271132) must
be fitted to each output cable as near as possible to the output
connector.
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Signal Type:
RGB Levels:

RGB Sync:
Pixel Clock:
Output Formats:

Color Depth:
Scan Rate:
Scan Mode:
DDC:

Scaling Engine:
Scaling Factor:
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DVI-1.0 or Analog RGB.

Video: 0.7V £1% into 75Q;

Sync: 2.4V into 2K2.

RBGHV (H & V TTL sync).

25MHz — 165MHz.

Up to SXGA (1280x1024) 50Hz using four outputs;

Up to SXGA+ (1408x1050) 59.94Hz using two outputs;
(for a full list of output formats see page 85)

24-bit maximum.

50 or 59.94 Hz.

Progressive or Interlaced.

Not supported.

370Mpixels/s real-time using ES patented convolver.
Variable from unity up to 16 times native resolution, both
horizontally and vertically.
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APPENDIX A:

Control Protocol
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Command Summary

IMAGESTAR HD USER GUIDE

Setup and control commands for ImageStar HD fall broadly into three categories, according to their
function and/or place within the signal processing chain:

Device Setup
Input Setup

Output Setup

Source Processing

e.g. defining network settings
e.g. selecting the source type, adjusting image quality,

e.g. setting the magnification factor,

e.g. setting the screen resolution and mapping.

The following diagram shows the processing chain, summarizes each of the commands and shows
how each fits into the chain:

Device Setup

Input Setup

Source Processing

Output Setup

IPADDSet
Sets the IP Address of the
device.

MASKSet
Sets the subnet mask of
the device

GatewaySet

Sets the IP Address of the
default network gateway
server

SaveNetwork
Commits new network
settings to the device
memory

SetDefaults
Returns device setup to
the factory-set default.

GetVersion
Obtains details of the
currently installed
firmware.

SetAutoDet

Enables Auto Detect
mode on a specified input
or, if already in this mode,
forces the source to be
re-detected.

SetlpMode

Disables Auto Detect
mode on a specified input
and configures it for a
predefined source type.

SetlpModeCurrent
Disables Auto Detect
mode and retains the
current configuration for
the specified input.

SetViewport
Adjusts the viewport for
the specified source.

SetAdjust

Adjusts the contrast,
brightness, clocking and
positioning of the
specified source (applies
to RGB Inputs 1 & 2 only)

SetClip

Specifies the source to be
displayed by the outputs
and sets the magnification
applied.

SetOpMode

Sets the format/resolution
for all four display
outputs.

SetOscan

Sets the overscan or
underscan factor required
by the display devices.

SetMap

Defines the region of the
magnified image to be
displayed by a specified
output.

SetOffset

Applies a position offset
to the image on a
specified output, to allow
correct stitching of the
target display screens.
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Command String Format

The format of each command string comprises the command name (e.g. SetAutoDet) followed by six
user-definable values or arguments:

<command name>=<argi>,<arg2>,<arg3>,<arg4>,<argb>,<arg6>\r
Taking the example of SetAutoDet, the command string would look as follows:
SetAutoDet=0,0,0,0,0,0\r
Please note:

e All six arguments must be present even if they are not used. Unused arguments are ignored
but we recommend that they be set to 0

e Commas must separate each argument

e The command string must terminate with \r
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Sending Commands to ImageStar HD

The recommended method of sending commands to ImageStar HD is to use HyperTerminal™.
HyperTerminal is a terminal emulation program that is supplied with Windows operating systems.

You will need a PC or laptop (running HyperTerminal) connected to ImageStar HD either via a LAN or
direct connection using a crossover patch cable:

Direct Connection (via crossover cable)

CONFIG
PC

Indirect Connection (via local area network)

CONFIG

IMPORTANT: The PC/laptop will need to be on the same subnet as the ImageStar HD.

Creating a Command File

The command(s) that you want to send to ImageStar HD must be saved in an ASCII text file. The
easiest way to do this is to use Windows Notepad.

HINT: The ImageStar HD Configuration software can export commands to a text file.

For example, the following shows a text file containing five commands that set up the outputs of one
ImageStar HD as part of a 3 x 3 target display, using 1280x720p screens:

I Imagestar1.txt - Notepad

File Edit Format View Help IMPORTANT NOTES:

e Each line must start with a space character.
SetMap=0,0,0,1280, 720, 0% . .
Setmap=1,1280,0,1280, 720, O\F e A blank line is recommended at the start of
R S W TR e S the file and between each command type.
serc1ip=0,0,0, 3830, 2159, O\r * The order in which commands are sent is not

satopMode=17, 0,0, 0,0, O\r critical.
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Preparing HyperTerminal

i Start HyperTerminal — Start | All Programs | Accessories | Communications |
HyperTerminal.

The following dialog will appear:

Connection Description EI E‘

Enter a name and choose an icon for the connection:

Name:
ImageStar Setup

1> Type in a Name for the new connection (e.g. ImageStar Setup).

1z Click OK — the following dialog will appear:

Connect To

"y |mageStar Sebup

Enter detailz for the host that pou want to call
Host address:  [172.28.232 64

Paort number: 37h32

Connect using: | TCRAP Mwinzock] v

[ oK H Cancel ]

i In the Connect using list box choose the TCP/IP (Winsock) option.
1> Type in the IP address of the ImageStar HD in the Host address box.
1z Type the number 37532 in the Port number box.

> Click OK.

HyperTerminal will now try to connect to the ImageStar HD. If the connection is successful
the status bar will show ‘Connected’ on the left hand side:

<
‘Connected 0:00:23 Auto detect TCR{IP
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If the connection fails for any reason the status bar will show ‘Disconnected’ and a warning
message will appear, e.g.:

HyperTerminal

If this occurs check the cable connections and that your PC/laptop is on the same subnet as
ImageStar HD.

1 From the File menu, choose Properties to open the following dialog:

ImageStar Setup Properties

Cornect Ta | Settings
Function, arrow, and cirl keys act as

®{Teminal keys O Windows keys

Backspace key sends
® C+H O Del O Chl+H. Space, Cil+H

Ermulation:

;_Auto detect il v-_
Telnet teminal ID: | 4N

Backscroll buffer lines: ;-SDD

|

[] Play sound when connecting ar disconnecting

[ Input Translation... ] [ ASCI Setup... ]

1z Select the Settings tab and click the ASCII Setup button.

ASCII Setup PIX

A5CI Sending

Send line ends with line feeds
Echo typed characters locally
Lime delay: | 8000 | miligeconds.

LCharacter delay: |0 milizeconds.

ASCI Receiving

[] Append line feeds ta incoming line ends
[] Farce incoming data ta 7-bit ASCII
‘wirap lines that exceed terminal width

[ 0K ][ Cancel ]

1> Ensure that both Send line ends with line feeds and Echo typed characters locally are
selected.

i Type in a Line Delay of 8000 milliseconds.

This will create an 8 second delay between each command in your command file. This delay
is necessary to allow ImageStar HD enough time to process and act on each command.

i Click OK on all open dialog boxes.

= From the File menu choose Save.

Page 74 1460GB issue 4



IMAGESTAR HD USER GUIDE Appendix A: Control Protocol

Sending a Command File

NOTE: Before following this procedure you need to have created one or more command files.
See ‘Creating a Command File’ on page 72.

1> From the HyperTerminal Transfer menu choose Send Text File.

The browse dialog will open:

Send|Text File Bx
Look in: | (.3 ImageStar Command Files V. 0 ¥ > E'
5 IE
LD ||@mes P

agestar 4x1 ¥GA Setup,bxk

My Recent
Docurnents

My Documents
50
My Computer
MyNetwork | Filescflype: [ Te fle [ TT] v

1> Browse to the required file, select it and click Open.

HyperTerminal will begin sending the commands in the file. Note that, because of the line
delay, this will take approximately 8 seconds per command.

i To send another file simply repeat the above process.

1z When you have finished setting up the ImageStar HD terminate the connection by clicking
the & (Disconnect) button in HyperTerminal.
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Device Setup Commands

IPADDSet

Function Sets the IP Address of the device.
NOTE: The new address is not saved until the SaveNetwork command is issued.
The device must then be rebooted to start using the new address.

Format IPADDSet=<ip1>,<ip2>,<ip3>,<ip4>,0,0\r

Arguments <ip1... 4> are the four parts of the IP address, each in the range 0 to 255 with no
leading zeros.

Example IPADDSet=172,28,232,21,0,0\r
Sets the IP Address to 172.28.232.21.

MASKSet

Function Sets the subnet mask of the device.
NOTE: The new subnet mask is not saved until the SaveNetwork command is
issued. The device must then be rebooted to start using the new subnet mask.

Format MASKSet=<sn1>,<sn2>,<sn3>,<sn4>,0,0\r

Arguments <snl... 4> are the four parts of the subnet mask, each in the range 0 to 255 with
no leading zeros.

Example IPADDSet=255,255,0,0,0,0\r
Sets the IP Address to 255.255.0.0.

GatewaySet

Function Specifies the IP Address of the default Gateway server on the network.
NOTE: The new address is not saved until the SaveNetwork command is issued.
The device must then be rebooted to start using the new address.

Format GatewaySet=<ip1>,<ip2>,<ip3>,<ip4>,0,0\r

Arguments <ip1... 4> are the four parts of the IP address, each in the range 0 to 255 with no
leading zeros.

Example GatewaySet =172,28,230,20,0,0\r

Specifies the Gateway IP Address as 172.28.230.20.
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SaveNetwork

Appendix A: Control Protocol

Function

Commits new network settings (using IPADDSet, MASKSet and GatewaySet) to
the ImageStar HD flash memory.

NOTE: The device must be rebooted after issuing this command before it will start
using the new settings.

Format SaveNetwork=0,0,0,0,0,0\r
Arguments None.
Example SaveNetwork=0,0,0,0,0,0\r

Saves the current network settings to flash memory.

SetDefaults

Function Returns the device setup (excluding network settings) to the factory-set defaults.
All current settings will be lost.
The default settings are:
Output Mode: XGA 60Hz (mode 5) no genlock
Screen Map: 2x2 XGA with no over/underscan or offset
Source Clip: 2x2 XGA from current graphics source
Format SetDefaults=0,0,0,0,0,0\r
Arguments None.
Example SetDefaults=0,0,0,0,0,0\r
Returns the device setup (excluding network settings) to the factory-set defaults
GetVersion
Function Obtains details about the currently installed firmware.
Format GetVersion=0,0,0,0,0,0\r
Arguments None.
Example Type GetVersion=0,0,0,0,0,0\r into the HyperTerminal window and press the

<enter> key. The firmware and flex versions will be displayed:

“& ISHDNet - HyperTerminal
File Edit Wiew Call Transfer Help

D& © 8 ;0o

GetVersion=0,0,0,0,0,0\r
Firmware:vl.0.0.17 11th May 2007: :FPGA:QutputScalerS0C_v253t . flx
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Input Setup Commands

IMAGESTAR HD USER GUIDE

SetAutoDet
Function Enables Auto Detect mode on a specified input or, if already in this mode, forces
the source to be re-detected.
Format SetAutoDet=<channel>,0,0,0,0,0\r
Arguments <channek is the input channel number:
0 = Input 1 (RGB)
1 = Input 2 (RGB)
2 = Input 3 (VIDEO / S-VIDEO)
3 =Input 4 (VIDEO)
Example SetAutoDet=3,0,0,0,0,0\r

Sets Input 4 to auto detect mode.
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SetlpMode
Function Disables Auto Detect mode on a specified input and configures it for a predefined
source type.
Format SetlpMode=<channel,<mode numbers,<sync type>,<color space>,0,0\r
Arguments <channek is the input channel number:
0 = Input 1 (RGB)
1 = Input 2 (RGB)
2 = Input 3 (VIDEO / S-VIDEO)
3 = Input 4 (VIDEO)
<mode numbers is a number representing the required source type:
Refer to table on page 80.
<sync type> is a number representing the sync type for an RGB signal:
For inputs 1 and 2 only, using RGB sources:
0 = Separate H and V
1 = Composite Sync (on H channel)
2 = Sync on Green/Tri-Level
For input 3 only:
0=CVBS
1 = S-Video (Y on input 3, C on input 4)
<color space> is a number representing the color space:
For inputs 1 and 2 only:
0=YCrCb
1=YPrPb
2=RGB
Examples SetlpMode=1,30,0,2,0,0\r

Configures input 2 to XGA 60Hz DMT using RGB with separate H and V sync.

SetlpMode=2,8,1,0,0,0\r

Configures input 3 (and 4) to NTSC 4.43 TAPE using S-Video.
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SetlpMode — RGB Mode Numbers (where <channel> = 0 or 1)

oo~NOOGOBRAWN=-0O

37
38
39
40
41
42
43

VGA 60Hz [640x480] DMT
VGA 60Hz [640x480] GTF

= VGA 60Hz [640x480] CVT
= VGA 72Hz [640x480] DMT
= VGA 72Hz [640x480] GTF

= VGA 72Hz [640x480] CVT
= VGA 75Hz [640x480] DMT
— VGA 75Hz [640x480] GTF

= VGA 75Hz [640x480] CVT
- VGA 85Hz [640x480] DMT
— VGA 85Hz [640x480] GTF

— VGA 85Hz [640x480] CVT
= IBM 70Hz TEXT [720x400]
NTSC 60

PAL 50

= SVGA 56Hz [800x600] DMT
- SVGA 56Hz [800x600] GTF
= SVGA 56Hz [800x600] CVT
= SVGA 60Hz [800x600] DMT
- SVGA 60Hz [800x600] GTF
- SVGA 60Hz [800x600] CVT
= SVGA 72Hz [800x600] DMT
SVGA 72Hz [800x600] GTF
SVGA 72Hz [800x600] CVT
= SVGA 75Hz [800x600] DMT
= SVGA 75Hz [800x600] GTF
SVGA 75Hz [800x600] CVT
SVGA 85Hz [800x600] DMT
- SVGA 85Hz [800x600] GTF
- SVGA 85Hz [800x600] CVT
- XGA 60Hz [1024x768] DMT
- XGA 60Hz [1024x768] GTF
- XGA 60Hz [1024x768] CVT
= XGA 70Hz [1024x768] DMT
- XGA 70Hz [1024x768] GTF
XGA 70Hz [1024x768] CVT
XGA 75Hz [1024x768] DMT
- XGA 75Hz [1024x768] GTF
= XGA 75Hz [1024x768] CVT
- XGA 85Hz [1024x768] DMT
= XGA 85Hz [1024x768] GTF
= XGA 85Hz [1024x768] CVT

— HD 720p VESA 50Hz [1280x720] GTF
= HD 720p VESA 50Hz [1280x720] CVT

44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83

NOTE: CVT = Coordinated Video Timing

HD 720p VESA 60Hz [1280x720] GTF
HD 720p VESA 60Hz [1280x720] CVT
= HD 720p SMPTE 50Hz [1280x720]

= HD 720p SMPTE 59.94Hz [1280x720]
= WXGA 60Hz CVT [1280x768]

= WXGA 75Hz SOG [1280x768]

= WXGA 85Hz [1280x768] CVT

= WXGA 85Hz SOG [1280x768]

= SXGA 60Hz [1280x1024] DMT

= SXGA 60Hz [1280x1024] GTF

= SXGA 60Hz [1280x1024] CVT

= SXGA 70Hz [1280x1024] GTF

= SXGA 70Hz [1280x1024] CVT
SXGA 75Hz [1280x1024] DMT
SXGA 75Hz [1280x1024] GTF

= SXGA 75Hz [1280x1024] CVT

= SXGA 85Hz [1280x1024] DMT

= SXGA 85Hz [1280x1024] GTF

= SXGA 85Hz [1280x1024] CVT

= SXGA+ 60Hz [1400x1050] GTF

= SXGA+ 60Hz [1400x1050] CVT

= UXGA 60Hz [1600x1200] DMT
UXGA 60Hz [1600x1200] GTF
UXGA 60Hz [1600x1200] CVT

= UXGA 70Hz [1600x1200] DMT

= UXGA 70Hz [1600x1200] GTF

= UXGA 70Hz [1600x1200] CVT

= UXGA 75Hz [1600x1200] DMT

= UXGA 75Hz [1600x1200] CVT

= 1080p 50Hz [1920x1080] SMPTE

= 1080p 59.94Hz [1920x1080] SMPTE
= 1080i 50Hz [1920x1080] SMPTE

= 1080i 59.94Hz [1920x1080] SMPTE
= 1080p 50Hz [1920x1080] VESA GTF
= 1080p 50Hz [1920x1080] VESA CVT
1080p 60Hz [1920x1080] VESA GTF
1080p 60Hz [1920x1080] VESA CVT
= HD 720p SMPTE 60Hz [1280x720]

= 1080p 60Hz [1920x1080] SMPTE

= 1080i 60Hz [1920x1080] SMPTE

DMT = Discrete Monitor Timings

GTF = Generalized Timing Formula

SMPTE = SMPTE 274M Standard (for 1080i/p)
or SMPTE 292M Standard (for 720p)

SetlpMode - Video Mode Numbers (where <channel> = 2 or 3)

aAr,wWN-=-0O

=NTSC M TAPE
=NTSC M DISK

= PAL B-D-G-H-I-N TAPE
= PAL B-D-G-H-I-N DISK
= PAL M TAPE

= PAL M DISK

6 =PAL COMBINATION-N TAPE
7 =PAL COMBINATION-N DISK
8 =NTSC 4.43 TAPE

9 =NTSC 4.43 DISK

10 =SECAM TAPE

11 =SECAM DISK
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SetlpModeCurrent
Function Retains the current configuration and disables Auto Detect for the specified input.
Format SetlpModeCurrent=<channel>,<color space override>,<color space>,0,0,0\r
Arguments <channek is the input channel number:

0 = Input 1 (RGB)

1 = Input 2 (RGB)

2 = Input 3 (VIDEO / S-VIDEO)

3 = Input 4 (VIDEO)

<color space override> defines whether or not the color space is retained for
RGB/YPrPb/YCrCb sources:

0 = retain current color space
1 = replace current color space with that specified by <color space>

<color space> defines the new color space:

0=YCrCb
1=YPrPb
2=RGB
Examples SetlpModeCurrent =1,0,0,0,0,0\r

Saves the current configuration for input 2, retaining the current color space.
SetlpModeCurrent =0,1,2,0,0,0\r

Saves the current configuration for input 1, but forcing the color space to RGB.
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SetViewport

Function

Adjusts the viewport for the specified source.

NOTE: A minimum viewport of 95% is always applied to video sources to remove
unwanted blanking, etc.

Format

SetViewport=<channel>,<horizontal size>,<vertical size>,
<horizontal position>,<vertical position>,0\r

Arguments

<channek is the input channel number:

0 = Input 1
1 =Input 2
2 =Input 3
3 =Input 4

RGB)

RGB)

VIDEO / S-VIDEO)
VIDEO)

—_

The two <...size> values set the size of the viewport relative to the entire source
frame and are defined as follows:

percentage viewport x 4096 + 100
For example 90% = 90 x 4096 + 100 = 3686.

The two <...position> values are measured in pixels and define the top left corner
of the viewport relative to the input source.

Example

SetViewport=3,3686,3686,5,5,0\r

Creates a 90% viewport for input 4 with the top left corner 5 pixels in from the left
of the source and 5 pixel down from the top.
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SetAdjust

Function Adjusts the contrast, brightness, clocking or positioning of the specified source
(applies to RGB Inputs 1 & 2 only)

Format SetAdjust=<channel>,<parameters,<adjustment>,0,0,0\r

Arguments <channek is the input channel number:

0 = Input 1 (RGB)
1 = Input 2 (RGB)

<parameter> defines which attribute of the source to adjust:

0 = contrast

1 = brightness

2 = horizontal start
3 = vertical start

4 = pixels per line
5 = clock phase

<adjustment> defines the amount of adjustment required and must be a number
between —32 and +32.

Examples SetAdjust =0,0,-5,0,0,0\r
Decreases the contrast of input 1 by a factor of 5.
SetAdjust =1,3,10,0,0,0\r

Shifts the vertical start position of input 2 down by 10 pixels.
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Source Processing Commands

SetClip
Function Specifies the source to be placed on the target display and sets the magnification
to be applied.
Format SetClip=<channel>,<top left horizontal position>,<top left vertical position>,
<bottom right horizontal position>,<bottom right vertical position>,0\r
Arguments <channek is the input channel number:
0 = Input 1 (RGB)
1 = Input 2 (RGB)
2 = Input 3 (VIDEO / S-VIDEO)
3 = Input 4 (VIDEO)
The four <...position> values are measured in pixels and define the boundary of
the selected source on the target display. The source is magnified to fit the
specified area. To make the source fill the target display area, this will always be
relative to the output mode resolution. For example, on a 2x2 display using XGA
(1024x768) screens:
<top left horizontal position> = 0
<top left vertical position> = 0
<bottom right horizontal position> = (2 x 1024) — 1 = 2047
<bottom right vertical position> = (2 x 768) —1 = 1535
Example SetClip=2,0,0,2047,1535,0\r
Places source input 3 on a 2x2 display using XGA display devices.
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Output Setup Commands

SetOpMode
Function Sets the output format for all four output channels.
Format SetOpMode=<mode number>,<genlock mode>,0,0,0,0\r
Arguments <mode numbers is a number representing the required output type:
0 =VGA (640x480) 50Hz
1 =VGA (640x480) 59.94
2 =SVGA (800x600) 50Hz
3 =SVGA (800x600) 59.94Hz
4 = XGA (1024x768) 50Hz
5 =XGA (1024x768) 59.94Hz
6 =1152x870 50Hz
7 =1152x870 59.94Hz
8 =SXGA (1280x1024) 50Hz
9 =SXGA (1280x1024) 59.94Hz
10 = SXGA+ (1408x1050) 50Hz*
11 = SXGA+ (1408x1050) 59.94Hz*
16 = HD 720p (1280x720) 50Hz
17 =HD 720p (1280x720) 59.94Hz
18 = WXGA (1376x768) 50Hz
19 = WXGA (1376x768) 59.94Hz
20 =WXGA (1280x768) 50Hz
21 =WXGA (1280x768) 59.94Hz
22 = PAL (704x574l) 50Hz
23 = NTSC (704x482l) 59.94Hz
24 =1080i (1920x1080I) 50Hz*
25 =1080i (1920x1080I) 60Hz*
26 =1080i (1920x1080I1) 59.94Hz *
NOTE: Modes marked * provide outputs on channel 1 and 2 only.
<genlock mode> is a number representing the genlock function:
0 = Genlock disabled (always use for RGB graphics)
1 = Genlock enabled and locked to the active YPrPb/YCrCb input
2 = Genlock enabled and locked to the active CVBS or S-Video input
Example SetOpMode=5,1,0,0,0,0\r
Configures all four outputs to XGA 59.94Hz with RGB genlock enabled.
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SetOscan

Function Sets the overscan or underscan factor required by the display devices.

Format SetOscan=<horizontal overscan>,<vertical overscan>,0,0,0,0\r

Arguments <horizontal overscan> and <vertical overscan> are specified as either a positive
number representing the amount of overscan or a negative number representing
the amount of underscan.

Typically the required overscan/underscan will be quoted as a percentage,
e.g. 8.5%. To obtain the value for this argument, multiply the percentage value
by 1024 then divide by 100.

Using the example of 8.5% will give 8.5x1024+100 = 87.04.
Round the answer up or down to the nearest whole number, i.e. 87.

Example SetOscan=87,87,0,0,0,0\r

Configures the outputs for 8.5% overscan horizontally and vertically. Values
derived from 8.5x1024+100 = 87.04 (rounded to 87).

SetOscan=-90, -120,0,0,0,0\r
Configures the outputs for —8.8% underscan horizontally and —11.7% underscan

vertically. Values derived from —8.8x1024+100 = —-90.112 (rounded to —90) and
—11.7x1024+100 = —119.808 (rounded to —120)
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SetMap

Function

Defines the region of the magnified image to be displayed by a specified output.

Format

SetMap=<output numbers,<top left horizontal position>,<top left vertical position>,
<horizontal size>,<vertical size>,0\r

Arguments

<output numbers is the output channel number:

0 = Output 1
1 = Output 2
2 = Output 3
3 = Output 4

The two <...position> and two <...size> values are measured in pixels and define
the boundary of the selected output on the target display. These are measured
relative to the source Clip (see SetClip). The <...size> values should always
match the screen resolution of each output (see SetOpMode).

Example

SetMap=0,0,0,1024,768,0\r
SetMap=1,0,1024,1024,768,0\r
SetMap=2,0,768,1024,768,0\r
SetMap=3,1024,768,1024,768,0\r

Maps the outputs to a 2x2 target display using XGA display devices.
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SetOffset

Function

Applies a position offset to the image on a specified output, to allow correct
stitching of the target display screens.

Format

SetOffset=<output numbers,<horizontal offset>,<vertical offset>,0,0,0\r

Arguments

<output numbers is the output channel number:

0 = Output 1
1 = Output 2
2 = Output 3
3 = Output 4

<horizontal offsets is an offset value measured in pixels. A negative value shifts
the image to the left, a positive number shifts it to the right.

<vertical offset> is an offset value measured in pixels. A negative value shifts the
image up, a positive number shifts it down.

Example

SetOffset=1,5,-10,0,0,0\r

Shifts the image on output 2 to the right by 5 pixels and up by 10 pixels.
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